
Prepare images

To sell your images on Alamy you must prepare them according to our submission guidelines, outlined below. Our customers like the depth 
and breadth of Alamy’s content and want to see images of the highest standard. So, whilst we welcome diversity and do not edit, our Quality 
Control Team check the technical quality of your images to ensure they meet our criteria.

The process

1. Prepare your images according to our submission guidelines below.
2. For your “test” submission, please send four images. Once your “test” submission has passed Quality Control (QC) you can send as 

many as you like.
3. We check your images for quality, reporting back with the result.
4. If your images pass QC, you can annotate them to make them available for sale.
5. You can track, annotate and manage your images in My Alamy .
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Submission guidelines

We need:

JPEG’s saved at a high quality setting (i.e. Photoshop level 10 or above).
Alpha-numeric file names ending in .jpg.
RGB files, not single channel greyscale or CMYK.
Uncompressed file sizes of more than 48MB, we recommend that you do not interpolate your files to more than 55MB. This means 
you should make your JPEG file from an 8 bit TIFF file that is at least 48MB. If you have a camera that is capable of producing an 
uncompressed 8 bit, TIFF file size of over 48MB then leave it that size.

We do not want:

images that contain glamour or pornography, or images which infringe the rights of any third party.
images that solely feature a logo or trademark - this is a copyright or trademark infringement.
a series of similar images with almost identical compositions or only slightly different exposures.

We reject images for (Hide all):

1. Camera shake The image is blurred or soft because the camera moved when the picture was taken. We reject images with this 
characteristic if we feel it was not artistically intended or it is unsaleable. Try using a faster shutter speed, steady hand, or a tripod.

2. Chromatic aberration Chromatic aberration
3. Mouseover to see red area at 100%
4. Click for high-res version

Chromatic aberration or ‘coloured fringing’ is shown as magenta/green or red/cyan fringing in areas of an image that have greater 
contrast. Poor quality optics and extreme wide-angle lenses tend to show Chromatic Aberration especially towards the edge of the 
frame. To remove this you can use the Chromatic Sliders in the Lens Correction Tool in Photoshop, most RAW conversion software 
has a similar tool. 

‘Purple fringing’ is a similar phenomenon, found in some digital cameras. It is caused by the optical characteristics of the camera 
sensor, and can extend right across the frame.

5. Colour cast 
6. Magenta colour cast
7. Click for high-res version

The image is tinted with an unwanted colour caused by incorrect white balance on your camera or scanner. Calibrating your monitor 
regularly can also help prevent colour casts. Although some colour choices can be seen as artistic, we will reject an image if we feel 
its colour cast makes it unsaleable.
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8. Compression artifacts Compression artifacts
9. Mouseover to see red area at 100%
10. Click for high-res version

The image has a blocky or patchy appearance caused by excessive compression. It is particularly noticeable in areas of flat colour 
such as skies and can appear as Jpeg "bubbles" around the edges of the image (see example). To minimise these artifacts work on 
your images in RAW or TIFF format and save as a Jpeg once only. 

11. Data loss or corruption Data loss or curruption
12. Mouseover to see red area at 100%
13. Click for high-res version

The image shows areas of subtle pixilation or zero data. To reduce the risk of this problem burn your CD or DVD at the slowest speed 
possible and make sure it is verified. Also check the first and the last few images on the disc for problems, as this is where most 
occur.

14. Digital camera not suitable for Alamy (pro level 6 mega pixel DSLR) The image shows a number of problems such as intrusive 
coloured (chroma) noise, degradation of image detail and/or interpolation artifacts. The image is from a digital camera which is below 
our recommended specification; a pro-level DSLR camera with a “true” (non-interpolated) resolution of at least 6 megapixels. This 
will give a uncompressed, 8 bit file size of at least 17MB. For more information, please see images from digital cameras.

15. Blemishes - Dust, scratches or sensor dust Sensor dirt
16. Mouseover to see red area at 100%
17. Click for high-res version

Dirt and scratches
18. Mouseover to see red area at 100%
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19. Click for high-res version

Small dark circles on the image are a common characteristic particularly noticeable in areas of flat colour such as skies. To reduce 
the risk of this occurring, clean your camera’s sensor or the material you intend to scan. You can also remove unwanted marks using 
the healing brush or clone tool in Photoshop .

20. Excessive sharpening Excessive sharpening
21. Mouseover to see red area at 100%
22. Click for high-res version

The image appears “edgy” or unsightly artifacts are visible. Sharpening should be applied only once and this is best done at the repro 
stage.

23. Excessive similars A series of similar images which have almost identical compositions or only slightly different exposures. We will 
only accept a series if the images have very different angles, framing or model’s expressions etc. However, you must tightly edit your 
images otherwise they will appear further down search results. Customers do not want to spend time editing through your work.

24. Film rebate or border Film rebate visible or not cropped
25. Click for high-res version

We do no accept any images with borders, whether they have been deliberately been put there or are from film scans. These must be 
cropped out.

26. High contrast High contrast
27. Mouseover to see red area at 100%
28. Click for high-res version

The image highlights are blown out and shadow detail is crushed.

29. Interpolation artifacts Interpolation artifacts
30. Mouseover to see red area at 100%
31. Click for high-res version

The image exhibits rather intrusive artifacts and degradation of detail resulting in an overall soft look, a “mottled” texture or "jaggies" on 

http://www.alamy.com/images/qc/dirt-scratches-large.jpg
http://www.alamy.com/images/qc/dirt-scratches-large.jpg
http://www.adobe.com/uk/products/photoshop/family/
javascript:togglerinline('sharpening');
http://www.alamy.com/images/qc/excessive-sharpening-large.jpg
http://www.alamy.com/images/qc/excessive-sharpening-large.jpg
http://www.alamy.com/images/qc/excessive-sharpening-large.jpg
http://www.alamy.com/images/qc/excessive-sharpening-large.jpg
http://www.alamy.com/images/qc/excessive-sharpening-large.jpg
http://www.alamy.com/images/qc/excessive-sharpening-large.jpg
http://www.alamy.com/images/qc/excessive-sharpening-large.jpg
javascript:togglerinline('similars');
javascript:togglerinline('rebate');
http://www.alamy.com/images/qc/film-rebate-large.jpg
http://www.alamy.com/images/qc/film-rebate-large.jpg
http://www.alamy.com/images/qc/film-rebate-large.jpg
http://www.alamy.com/images/qc/film-rebate-large.jpg
http://www.alamy.com/images/qc/film-rebate-large.jpg
javascript:togglerinline('contrast');
http://www.alamy.com/images/qc/high-contrast-large.jpg
http://www.alamy.com/images/qc/high-contrast-large.jpg
http://www.alamy.com/images/qc/high-contrast-large.jpg
http://www.alamy.com/images/qc/high-contrast-large.jpg
http://www.alamy.com/images/qc/high-contrast-large.jpg
http://www.alamy.com/images/qc/high-contrast-large.jpg
http://www.alamy.com/images/qc/high-contrast-large.jpg
javascript:togglerinline('artifacts');
http://www.alamy.com/images/qc/interpolation-large.jpg
http://www.alamy.com/images/qc/interpolation-large.jpg
http://www.alamy.com/images/qc/interpolation-large.jpg
http://www.alamy.com/images/qc/interpolation-large.jpg
http://www.alamy.com/images/qc/interpolation-large.jpg
http://www.alamy.com/images/qc/interpolation-large.jpg
http://www.alamy.com/images/qc/interpolation-large.jpg


edges. These symptoms occur when you interpolate an image beyond the capabilities of the camera from which it came. Our advice 
for images from digital cameras may help you track down the problem. 

32. Newton’s rings or interference patterns Newton’s rings
33. Mouseover to see red area at 100%
34. Click for high-res version

The image has a circular “rainbow” effect caused when scanning film. The scanning light reflects off of millions of small moisture 
particles on the surface of the film or glass carrier. Try to clean dirt and moisture off the film or carrier before you scan. The “Fine” 
setting in digital ICE can also cause this effect.

35. Noise Noise
36. Mouseover to see red area at 100%
37. Click for high-res version

Chroma noise gives a mottled, distorted effect that usually contains green and pink/purple colours. It can particularly cause problems 
on skin tones, skies and shadow areas. Electronic chroma noise is the appearance of distortion within a digital image usually caused 
by using high ISO levels when shooting. Different cameras are better at reducing the appearance of noise than others, but you should 
always try and shoot on as low an ISO level as possible.

38. Noticeable retouching Noticeable retouching
39. Mouseover to see red area at 100%
40. Click for high-res version

Noticeable retouching - cut out
41. Mouseover to see red area at 100%
42. Click for high-res version
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Retouching is obvious in the image. We recommend that you retouch at 100% and double check to ensure that it is not visible. 100% 
or 1:1 means one screen pixel displays one image pixel. Also retouching at more than 100% is problematic as the image is too 
enlarged to see any image detail or mistakes.

43. Orientation The image is not the right way up for viewing on a screen. It may be inverted, upside down or at an angle.
44. Out of focus We will reject an image if we feel that is not artistically intended to be out of focus. Also, it must look out of focus at 

thumbnail size so that it is obvious to our customers.

45. Over manipulated Over manipulated
46. Mouseover to see red area at 100%
47. Click for high-res version

The image is clearly over manipulated. Examples are the excessive use of “levels” or “curves” which leave an image looking 
posterised, “blocky” or with distorted colour.

48. Poor exposure Poorly exposed image / histogram
49. Mouseover to see correct exposure
50. Click for high-res version

The image appears rather flat or washed out. Correct exposure ensures maximum tonal range in an image. You can check and adjust 
the exposure using the histogram in Photoshop (Under Image > Adjustments > Levels).
With very few exceptions, we expect the black point of your images to be 0 and white to be 255. However, we will accept images 
where they are within 5% of this, i.e. Black at level 12 or below, white at Level 243 or above.

51. Scanning artifacts Scanning artifacts - banding
52. Mouseover to see red area at 100%
53. Click for high-res version
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Scanning artifacts - double edging
54. Mouseover to see red area at 100%
55. Click for high-res version

Characteristics include double edging, stripes or banding, particularly noticeable in shadows. For more scanning advice visit images 
from scanners.

56. Size The uncompressed file size of the image is under 48MB or exceeds 200MB. Based on our experience of customer requirements 
and to give you exposure to the largest possible market we advise you to supply file sizes between 48MB – 50MB. If you have a 
camera that is capable of producing an uncompressed 8 bit, TIFF file size of over 48MB then leave it that size. For more information, 
please see images from digital cameras.

57. Soft due to size Soft due to size
58. Mouseover to see red area at 100%
59. Click for high-res version

This is caused by over-interpolating (upsizing) images beyond their capabilities. As a rule we suggest that you keep your file sizes 
close to 48 – 50MB to avoid degrading image detail unnecessarily. If you have a camera that is capable of producing an 
uncompressed 8 bit, TIFF file size of over 48MB then leave it that size.

60. Soft or lacking definition Soft or lacking definition
61. Mouseover to see red area at 100%
62. Click for high-res version

The image may appear soft and / or lacking definition for one or more of the following reasons:
◦ The image has been interpolated beyond its limitations / an unsuitable camera has been used.

◦ The image is slightly out of focus.

◦ The image has been over-manipulated (such as overuse of noise reduction) causing degradation in image quality.

◦ There is slight camera shake / shake that was not evident before the image was upsized.

◦ A lens with poor optics has been used resulting in loss of fine detail.

◦ A dedicated film scanner has not been used / poor quality film scanned / image scanned poorly.

63. Unsuitable material Although the technical standard of your work maybe be fine, certain material is not suitable for our target market. 
This includes, but is not limited to glamour, pornography and images which infringe the rights of any third party. If you shoot this type of 
content you may have more sales success from an alternative outlet.

Notes

▪ We only import the ‘Caption’ and ‘Keywords’ IPTC fields from your images. For more information see IPTC headers in Photoshop.
▪ Although we do not edit, we strongly recommend that you edit your images yourself before submitting.
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Quality Control (QC) policy

We fail images which do not meet our submission guidelines. Check the quality of each image before you submit.

Test submissions

▪ For your test submission you need to send in only 4 images.
▪ We check all 4 images and they must all pass QC for your submission to be accepted. Do not submit any additional images until your 

initial test has passed QC.
▪ If your test submission fails we will give you failure reasons for all images which do not meet our QC criteria.
▪ Avoid rejection by checking each of your images at 100% with professional imaging editing software such as Adobe Photoshop.

Ongoing submissions

▪ Once you’ve passed your QC test we only check a sample of images in subsequent submissions.
▪ A submission is defined as any group of media that are awaiting QC at the same time regardless of the day they were submitted (they 

will all have the status “Awaiting QC”).
▪ If we fail one image, we will reject all images in all media awaiting QC.
▪ Media grouped together as a submission will be QC’d together and will have the same QC date in “Track submissions”.
▪ We will indicate the media which contains the failed image, with an information icon in Track submissions.
▪ Avoid rejection by always checking each of your images at 100% looking for all possible QC failure reasons.
▪ The average amount of time for a contributor to wait for their QC outcome is 48 hours – please note that we do not undertake any QC 

at the weekend.
▪ Ongoing QC failures can result in your online upload privilege being frozen for 30 days and in extreme circumstances your account 

being terminated. Blog post on freezing procedure
▪ QC waiting time is dependent on your QC history, failing QC successive times harms your QC rank meaning that it may take longer 

for your work to be quality controlled. Blog post on QC time dependent on your QC history.
Top

Alamy Recommended Digital Camera List

Our Alamy Quality Control (QC) Team see a wide variety of images from various digital cameras.

We have put together a list of recommended digital cameras. This shows cameras that are capable of producing images that meet our QC 
standards when used in varied conditions.

All cameras included in this list need to be used at their optimum settings and the images carefully processed using a professional image 
software package such as Adobe Photoshop.

At present we recommend the following cameras for submissions to Alamy:

Canon:

▪ Canon EOS-1Ds Mark III
▪ Canon EOS 5D Mark II
▪ Canon EOS-1Ds Mark II
▪ Canon EOS-1D Mark IV
▪ Canon EOS 7D
▪ Canon EOS 5D
▪ Canon EOS-1D Mark III
▪ Canon EOS-1D Mark II
▪ Canon EOS-1Ds
▪ Canon EOS 50D
▪ Canon EOS 40D
▪ Canon EOS 500D / Digital Rebel T1i
▪ Canon EOS 450D / Digital Rebel Xsi / EOS KISS X2
▪ Canon EOS 30D
▪ Canon EOS 1000D / Digital Rebel XS
▪ Canon EOS 400D / Digital Rebel XTi
▪ Canon EOS 20D
▪ Canon EOS 350D

Nikon:

▪ Nikon D3X
▪ Nikon D3S
▪ Nikon D3
▪ Nikon D700
▪ Nikon D300S
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▪ Nikon D300
▪ Nikon D2X / D2Xs
▪ Nikon D90
▪ Nikon D200
▪ Nikon D5000
▪ Nikon D3000
▪ Nikon D60
▪ Nikon D80
▪ Nikon D40X

Panasonic:

▪ Panasonic Lumix DMC-GF1
▪ Panasonic Lumix DMC-GH1
▪ Panasonic Lumix DMC-G1
▪ Panasonic Lumix DMC-L10

Samsung:

▪ Samsung GX-20
▪ Samsung GX-10
▪ Samsung GX-1s
▪ Samsung NX10

Contax:

▪ Contax N Digital
Epson:

▪ Epson R-D1x
▪ Epson R-D1

Fuji:

▪ Fuji S5 Pro
Leica:

▪ M9
▪ M8.2
▪ M8
▪ X1

Olympus:

▪ Olympus E620
▪ Olympus E-30
▪ Olympus E-520
▪ Olympus E-450
▪ Olympus E-420
▪ Olympus E-3
▪ Olympus E-510
▪ Olympus E-410
▪ Olympus E-400
▪ Olympus PEN E-P2
▪ Olympus PEN E-P1

Pentax:

▪ Pentax K-7
▪ Pentax K20D
▪ Pentax K200D
▪ Pentax K10D / Grand Prix
▪ Pentax K-x
▪ Pentax K2000 (K-m)

Ricoh:

▪ Ricoh GXR A12
Sony:

▪ Sony DSLR A900
▪ Sony DSLR A850
▪ Sony DSLR-A700
▪ Sony DSLR-A550
▪ Sony DSLR-A500



▪ Sony DSLR-A450
▪ Sony DSLR-A380
▪ Sony DSLR-A350
▪ Sony DSLR-A330
▪ Sony DSLR-A300
▪ Sony DSLR-A230
▪ Sony DSLR-A200
▪ Sony DSLR-A100

Please note, there may be other digital cameras that can produce files which would also be acceptable to Alamy.

Last updated January 2010.

Alamy unsuitable camera list

Please check your camera from the list below. We ask that you do NOT submit any images from camera models featured on the list. Camera 
models featured on this list do not produce files that are capable of passing Alamy’s QC standards.

Click on the manufacturer’s name below to check your camera:

▪ Acer
▪ Aiptek
▪ AgfaPhoto
▪ BenQ
▪ Canon
▪ Casio
▪ Centon
▪ Concord
▪ Contax
▪ Digital Dream
▪ Epson
▪ Easypix
▪ Fujifilm
▪ GE
▪ Genius
▪ Hitachi
▪ Hyundai
▪ HP
▪ IT Works
▪ Jenoptik
▪ Kodak
▪ Konica
▪ Minolta
▪ Kyocera
▪ Leica
▪ Minox
▪ Mustek
▪ Nikon
▪ Olympus
▪ Panasonic
▪ Pentax
▪ Polaroid
▪ Praktica
▪ Ricoh
▪ Rollei
▪ Samsung
▪ Sanyo
▪ Sealife
▪ Sigma
▪ Sony
▪ Technika
▪ Toshiba
▪ Trust
▪ Vistaquest
▪ Vivitar
▪ Yashica
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Images from digital cameras

Digital cameras are now capable of producing top quality results and have become increasingly popular with professional photographers. Our 
standard advice for preparing digital camera files for Alamy is as follows:

▪ Use a pro-level DSLR camera with a “true” (non-interpolated) resolution of at least 6 megapixels. This will give an uncompressed file 
size of at least 17MB at 8 bit.

▪ Carefully consider your choice of lens. Lens quality is just as important today as it ever was.
▪ The choice between shooting in RAW, Tiff or JPEG is a matter for your own workflow. Shoot in RAW for maximum control in post-

processing. If shooting in JPEG, always use the “Fine” (least compressed) setting. Modern professional DSLRs produce excellent 
jpegs, which are visually indistinguishable from RAW or Tiff. With lesser cameras it may be necessary to shoot in RAW to achieve 
acceptable image quality.

▪ Capture images at as low an ISO setting as practicable.
▪ Turn off all in-camera sharpening.
▪ Before working on fine JPEG’s, they should first be resaved as tiffs or another non-lossy format, e.g. psd. Never resave JPEG’s in 

JPEG format - this will result in permanent loss of data and degraded image quality.
▪ RAW files should be checked for correct exposure, colour cast, etc, and any adjustments should be made at this stage. When 

converting from RAW, ensure all sharpening is turned off - it’s applied by default in Photoshop.
▪ If necessary, rotate the image so that it’s “the right way up”.
▪ Do not crop your images excessively - after cropping, your file should still have an uncompressed file size at least 17MB at 8 bit.
▪ Interpolate (upsize) the file to 48 – 50MB using a specialist, professional software package. We recommend Abobe Photoshop 

although other software is acceptable. If using Photoshop version 7 or higher select the bicubic option. We advise that you do not use 
“step” or incremental interpolation. Check your software’s default settings to ensure that all sharpening is turned off.

▪ Now open the image at 100%, and check for dust contamination on the sensor. This shows up as dark, circular marks - particularly 
noticeable in the sky and similar areas. Thoroughly check the upsized image at 100% and make any necessary corrections using the 
Clone Tool, Healing Tool or the History Brush technique as appropriate.

Images from scanners
▪ Many reasonably priced desktop scanners can produce medium format (and larger) scans which meet Alamy’s technical 

requirements. When scanning 35mm we recommend that you use a dedicated film scanner to ensure that you get the best results. Follow 
these steps to get the best from your film images.

▪ We ask that scans are not interpolated and are at their native resolution, these must meet our minimum file size which is 
48MB or above.

▪ Shooting images on film

▪ Images need to be of the highest possible technical quality. In general, shoot on the finest grain film, and with high quality 
lenses. Please note, however, that fine grain film is inherently high in contrast. If you are shooting images which are going to be scanned, try 
to keep the contrast down. However, do not go to the other extreme and shoot images with a ‘flat’ contrast.

▪ Scanning prints

▪ We do not recommend scanning prints as an alternative to scanning negatives or transparencies, scanning these will give 
superior results. If you are thinking of scanning prints then you must remember the quality of the original print is paramount - it must be sharp, 
with good colour saturation, and without excessive contrast. As with film, the scanner should be of the best quality possible. As a rough guide, 
a 10 x 8 inch print will need to be scanned at around 500ppi.

▪ Film formats

▪ 35mm originals
To achieve a 70MB file from a full frame 35mm transparency, requires a scan resolution of approximately 4000ppi.

▪ 6 x 6cm and 5 x 4" originals
The larger the film area, the lower the scanning resolution needs to be to achieve a 70MB file. Medium format transparencies require a 
scan resolution of around 2000ppi, whilst a 5 x 4" original will need to be scanned at around 1000ppi.

▪ Scanning images from film

▪ Choose a scanner with high quality optics, and a dynamic range (Dmin-Dmax) of at least 4.0.
▪ When scanning 35mm make sure that you use a dedicated film scanner. Using a flatbed scanner to scan 35mm will give results that 

are soft and unsuitable for submission to Alamy.

http://www.adobe.com/products/photoshop/main.html


▪ Do not scan above the maximum optical resolution of your scanner. Most scanners offer scanning settings way above their optical 
maximum. This is achieved by interpolation and results are usually unsatisfactory. Scan at the true optical resolution required to give a 
file size of at least 48MB at 8 bit. For 35mm, scanning a mounted transparency at 4000ppi will give a file size of around 50-55MB. 
Scanning an un-mounted transparency/negative at 4000ppi will give 65-70MB.

▪ We ask that scans are sent to us uninterpolated (at 48MB or above).
▪ Using your scanner software, set the black/white points at, or close to, 0/255.
▪ Ensure sharpening is turned off.
▪ Scan at the highest bit depth available, but convert to 8 bit before submission to Alamy. (Image>Mode>8 Bits/Channel)
▪ Difficult subjects may need a multi-pass scan to reduce scanning artefacts and capture maximum detail from the film.
▪ If using Digital ICE, we recommend the "Normal" setting. The "Fine" setting slightly softens the image. Digital ICE cannot be used with 

black and white film and can be problematic with Kodachrome film.
▪ If necessary, rotate the image so that it’s "the right way up".
▪ Open the scan at 100% and check that none of the film rebate is visible - if it is, crop cleanly to the edge of the image area.
▪ Carefully check the entire image at 100% for dust, dirt, scratches and other blemishes. These can be corrected using the Clone Tool, 

Healing Tool or the History Brush technique as appropriate.

Improving image quality

Calibrate your monitor

The appearance of your digital images will vary according to the monitor you use, and again on the printed page. One vital operation to carry 
out regularly is to calibrate your monitor. This can be done with specific software packages and on screen meters, or more easily with the 
Adobe gamma software, which is an integral part of Photoshop. If using a CRT, make sure that the monitor has been running for around half 
an hour before the calibration process, and that any ambient light is consistent with the normal working environment. Another important point 
is to make sure that you have a neutral grey desktop on your monitor, against which to view the images.

Colour Space

Unless you have reason to do otherwise, we recommend you use Adobe RGB (1998). This has become the defacto standard for most 
imaging professionals.

Colour Management

This is a matter for your own workflow. Alamy will disregard any embedded ICC profiles.

Exposure

The histogram is a graphical representation of the tonal values in an image. Check, and if necessary correct, exposure using the histogram 
(Levels). For most images the black point should be at or near 0, with the white point at or near 255. At Alamy we expect the black/white 
points to be within 5% of these values, i.e. black at Level 12 or below, and white at Level 243 or above. There are exceptions of course - for 
example, extreme high-key or low-key shots, and misty, atmospheric images may not contain the entire tonal range from black to white. This 
is perfectly OK.

In Levels, if most of the tonal values in the histogram are bunched up towards the left, the image is probably under-exposed. If bunched up 
towards the right, it's probably over-exposed. Use the centre slider (gamma) - or for more control use Curves - to try to improve matters, but 
there's a limit to how far you can go before image quality deteriorates. Raw shooters should go back to the original Raw file and make 
corrections there.

Noise Reduction

There are various software packages available for noise reduction. While some of these packages achieve very good results, they generally 
work by softening the image. We advise that you use them sparingly to avoid introducing softness and unsightly artifacts in your images, and 
to check your results at 100%.

Interpolation

When an image file is increased in size, software has to 'create' extra pixels to fill the gaps. It does this by estimating the brightness and 
colour of the new pixels, based on their neighbouring pixels. There are specialist software packages and techniques available, some methods 
are more successful than others. We require scans to be un-interpolated and digital camera files to be interpolated up to 48 – 50MB. If you 
have a camera that is capable of producing an uncompressed 8 bit, TIFF file size of over 48MB then leave it that size. If you need to 
interpolate your image’s digital camera files you must ensure that you use a professional software package, such as Abobe Photoshop.

http://www.adobe.com/products/photoshop/main.html


Check for a colour cast

With the Eyedropper Tool set to a sample size of 5x5 pixels, place the cursor over a known neutral (black, grey or white) area. Now check 
the RGB values in the Info Palette - they should all be identical. If they're not, use one of the various colour balance methods to make them 
equal.

Sharpening

The normal process of preparing an image for repro always includes sharpening. This is best done only once. If you apply sharpening to 
sharpening, unsightly artifacts can appear. So, please do not sharpen at any stage of your workflow.

Grayscale Images

If you are working with grayscale images, please save them as RGB prior to submission.

Check your images at 100%

Always carefully check the quality of your digital files at 100% before you submit them to us. 100% means that one monitor screen pixel is 
displaying one image pixel. This is the only way to see every pixel in your image, it is important that you check all of your images at this zoom. 
In Photoshop, the keyboard shortcut for 100% is Ctrl+Alt+0 (PC) or Cmd+Option+0 (Mac), or double-click the zoom tool.

Save your file

Save the image as a high quality JPEG file (level 10 or above in Photoshop). Ensuring your file name includes the ‘.jpg’ extension. You can set 
up Photoshop to automatically add the extension by going Photoshop > Preferences > File Handling > File Saving Options and select Append 
File Extension "Always".

Retouching techniques

Most digital images, like their film counterparts, will require some "spotting" or retouching. This might be of dust specks or hairs picked up at 
the scanning stage, or removal of small blemishes from the original image. Digital cameras are not immune. Dust on the camera sensor 
shows up as dark, circular marks, particularly noticeable in the sky and similar areas.

Software for retouching

Software such as Photoshop’s ‘dust & scratches‘ filter may save you time, but these techniques (including Digital ICE on the ‘Fine’ setting), 
generally work by softening the image. They do have their place, but try to use them selectively and sparingly. Take care that image detail is 
not degraded to an unacceptable degree. Again, you should check this at 100%.

Clone Tool/Healing Tool

Perhaps the most useful tool is the Clone Stamp Tool (keyboard shortcut ’S’), (fig.1). This can be used to copy pixel for pixel areas of tone, 
to eliminate defects such as spots or hairs.

1. First choose a suitable size of stamp (for this purpose ensure that in the preferences of Photoshop, you check the "brush size" box: 
File > Preferences > Display and Cursors > Brush Size, so you can see exactly the diameter of brush chosen), then put it into an area 
immediately next to the blemish to be removed. You can quickly alter the size of the brush using the keyboard shortcut ‘[‘ to decrease 
or ’]’ to increase. Using the command Alt+Click, samples this area.

2. Now move the stamp to the blemish and click the mouse. You will now see two cursors - the sampled point and the area to be 
improved. This starts to replace the pixels under the cursor with the ones sampled. This may take some getting used to but with 
practice even large blemishes can be effectively removed (fig.2).

 Figure 1.

 Figure 2.

The Healing Brush Tool (keyboard shortcut ‘J’) works in a similar way, but in addition tries to match the colour and tonality of the destination 
area, so selection of the source area is not quite so critical. The Healing Tool is very effective in open areas, but you’ll need to revert to the 
Clone Tool when near other objects.

The opacity of the tools can be altered, but, more importantly, the "blend mode". In normal mode the stamp literally clones pixels from one 
area to another. Try using the lighten and darken modes. In darken mode, the tool will only paint colour if the destination is lighter than the 



source, whilst in lighten mode the opposite will happen.

You may need to sample an area several times to prevent tell-tale repeat patterns. The Clone Tool can also be used like a spotting brush for 
removing small areas of dust and blemishes like the one shown in the illustration. Rather than painting with the tool, a single click is used to lay 
tone over the blemish. Use a soft edged brush slightly larger than the area to be removed (fig.3, 4).

 Figure 3.

 Figure 4.

The History Brush Technique

The History Brush Tool (keyboard shortcut ‘Y’) technique allows you to clean up large areas of dirt/dust quickly - so long as the area to be 
cleaned contains very little detail, or is out of focus or blurred, e.g. the sky or other background area.

1. First go Filter > Noise > Dust & Scratches... and choose a radius large enough to remove all the dust or blemishes. The whole image 
will be blurred but don’t worry about that for now.

2. Select the History Brush and in the History Palette, click on the small square box on the left of the Dust & Scratches history. This sets 
the origin for the History Brush.

3. Now click in the previous History state - the larger rectangular box immediately above and slightly to the right. This returns us to the 
un-blurred image.

4. With the Mode set to "Lighten" for transparencies, or "Darken" for negatives, paint over the dirt/dust with the History Brush. Magically, 
all traces of dust will vanish.

Level a Tilting Horizon

1. For this trick we need the Measure Tool. If it’s not visible in the Tools Palette, click on the Eyedropper Tool to reveal it.
2. Now draw along your tilting horizon.
3. Next, go Image > Rotate Canvas > Arbitrary... The precise angle required will already be entered - just click OK.
4. Also works with leaning verticals.

Remove Chroma Noise or Colour Aliasing

Noise can be a big problem with digital cameras, especially at high ISOs.

1. Go Filter > Blur > Gaussian Blur, select a large radius (e.g. 6 pixels or more) and blur the image so that you can no longer see the 
noise. The whole image will be completely blurred, but don’t worry about that.

2. Now go Edit > Fade Gaussian Blur and select Mode > Color from the drop-down menu, and click OK. This will return us to the 
unblurred state and should remove all the intrusive colour from the noise or aliasing.

Further Photoshop training and tutorials are available from Adobe.

http://www.adobe.com/

